
  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I65™, Red-I65T™, Red-I90™, Red-I90H™, Red-I90HS™, 
Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™, FloorChoice™ are trademarks of RedBuilt LLC, 
Boise ID, USA. Copyright © RedBuilt LLC. All rights reserved. 

 1 of 24 

Release Notes 
RedSpec™ 

 Version: 7.0.15 
 Release Date: May 9, 2012 
 Expiration Date: July 1, 2014 

 

Contents 

• Purpose of Release 
• Description of Changes 

 

Purpose of Release 

Version 7.0.15 is an external release of the numerous changes included in the release 
of 7.0.14, which was restricted to RedBuilt™ users. Please refer to the next three 
pages for a complete description of revisions that have occurred since 7.0.13, the 
last external release. 
 

Description of Changes 

Text Format Changes in Output 

Minor changes improve the consistency in format between the Results tab summary 
and the Print tab detailed output. 

Bug Fixes 

1. New hanger fastener codes 74 and 75 were not recognized. These are now 
translated to TTN25134H and TTN25234H, respectively. 

2. The RedLink.dll file installed via the 7.0.14 update was an older version, 
incompatible with the other changes in RedSpec™. The incompatibility 
prevented truss designs in 7.0.14. 
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Release Notes 
RedSpec™ 

 Version: 7.0.14 
 Release Date: April 24, 2012 
 Expiration Date: July 1, 2012 
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Purpose of Release 

Version 7.0.14 is an internal beta release for temporary use prior to the planned 
external release of 7.0.15. Changes are primarily bug fixes and minor new features. 
 

Description of Changes 

FloorChoice™ Parameters Added to Output 

The FloorChoice™ floor performance rating is affected by glued-and-nailed vs. nailed-
only sheathing, simple span vs. continuous spans, and rigid vs. flexible supports1. The 
selected parameters are now stated in the FloorChoice™ paragraph on the printout, in 
addition to the parameters of sheathing type, topping, ceiling, and blocking. 

Cut Length Assistance for Sloped Joists and Beams 

The horizontal projected length of a sloped member may be multiplied by the 
reciprocal of the cosine of the slope angle to obtain the sloped length. This factor is 
now provided in the notes on the printout, as well as the number of inches that must 
be added to account for a bevel cut. The note is displayed only for sloped I-joists and 
beams. When depth is an optimization variable, the bevel cut add is not shown. 

Required Bearing Length at Each Support 

The required bearing length for I-joist and beam members is given for each support on 
the printout. I-joist requirements are separated into “no stiffeners” and “stiffeners.” 

                                                
1 “Wall” and “Ledger” are rigid supports. “Beam” is a flexible support. 
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Previously the worst-case requirements for all supports were summarized in a note. 
The note is no longer used, unless the I-joist reaction capacity is exceeded. 

Net Uplift Reaction for Open-Web Trusses 

The net uplift reaction is shown in the results and printout for open-web trusses. In 
previous versions it was shown only if it was the critical load case. 

Hanger Database 

The hanger database is updated to the latest available from Simpson Strong-Tie®, 
dated 2/15/2012. 

Composite EI Update for Canadian Floor I-Joists 

Panel properties in accordance with CSA O86-09, Table 7.3C are used to derive 
composite stiffness of floor I-joists with glued sheathing under the NBC LSD code 
selection. Note that IF24 OSB sheathing is assumed. 

 

Bug Fixes 

1. Deflections were overstated on a joist design with replacement load and 
tapered load under NBC LSD. 

2. Vibration analysis was performed for all floor and roof I-joists under NBC LSD, 
although the results were not printed for roof joists. The vibration analysis is 
now bypassed on roof joists to speed processing. 

3. Certain designs with no positive moment would fail. For example, a design with 
a long overhang and additional loads on the overhang may have no positive 
moment under any load pattern. In this case the results would show an 
allowable moment of zero and a design percentage of 99999%. 

4. Truss designs that bear on the bottom chord would sometimes fail due to 
limited pin-to-end chord length at the bearing pin. To improve this, a vertical 
web at the bearing is now used whenever the truss slope is in the range of 
-0.5:12 to 0.5:12. It is not used on steeper slopes as this may lead to web-angle 
geometry issues at the high end. 

5. The optimization process showed a preference for a double Red-I45™ when a 
single Red-I90™ of the same depth was cheaper. In this case, series and plies 
were the variables. 

6. Optimizing a member with three spans and two overhangs lead to a “not 
responding” error message. 

7. The I-joist optimization process would result in error messages (e.g. “a feasible 
option is not found,” division by zero, or overstress) when series was a variable 
and a 20" depth was selected. 



  

RedBuilt™, RedSpec™, RedOpenWeb™, Red-I™, Red-I45™, Red-I65™, Red-I65T™, Red-I90™, Red-I90H™, Red-I90HS™, 
Red-L™, Red-LT™, Red-W™, Red-S™, Red-M™, Red-H™, RedLam™ are trademarks of RedBuilt LLC, Boise ID, USA. 
Copyright © RedBuilt LLC. All rights reserved. 

 4 of 24 

8. Sloped I-joists that failed in bearing would show a message box with the 
correct overstress percentage, but the percentage displayed in the printout 
was increased by the cosine of the slope. 

9. Hangers would not be found for certain sizes of sawn lumber because the joist 
type was incorrect in the hanger screen. 

10. Additional loads very near a support, other loads, or one end of the member 
could cause a “subscript out of range” loading error. 

11. A faulty product index prevented the finding of hangers for 3.5"x14" LVL, if the 
hanger style was set to “Any.” 

12. The bearing of an open-web truss could be shown as “Top” on the printout, 
even though the user had chosen “Bottom.” This would occur if a top-bearing 
simple bearing was changed to a bottom-bearing overhang. 

13. When optimizing for open-web truss series, the results would show the assumed 
bearing width and bearing clip for the last series checked, rather than the 
optimum solution. 

14. Cost factors in the product database are updated to ensure the Red-I65™ is 
ranked lower (i.e. more economical) than the Red-I90™ when a design is 
optimized with variable series, and both series are viable options. 

15. Long load comments were allowed for input, but the design could not be saved 
unless the comments were shortened. Comment input is now limited as the 
user enters it. 

16. Wrapping of long file names on the printout forced a second page. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.13 
 Release Date: August 26, 2011 
 Expiration Date: July 1, 2012 

 

Contents 

• Purpose of Release 
• Description of Changes 
• Addendum 5/8/12 

 

Purpose of Release 

Version 7.0.13 incorporates Red-I™ joist properties in accordance with the recently-
reissued ESR-29942. There are no other changes. 
 

Description of Changes 

Red-I™ Joist Properties 

The revised ESR-2994 includes a number of changes to joist properties for the building 
code and methodology selection “IBC ASD.” Designs under “NBC LSD” are not 
affected. No other products are affected. The Red-I™ property changes may be 
summarized as follows: 

• Increased allowable shear for Red-I45™, Red-I65™, Red-I90™, and Red-I90H™. 

• Increased allowable reaction for certain depths of these series, where reaction 
values are controlled by shear. 

Changes to ESR-2994 Section 4.6, “Holes in Red-I Joist Web,” are aligned with the 
RedSpec™ allowable hole shear analysis. This does not represent a change in 
RedSpec™. 
 
New joist series and depths introduced in the latest ESR-2994 are not incorporated in 
RedSpec™ at this time. 

                                                
2 ICC-ES Evaluation Report ESR-2994, Red-I™ Prefabricated Wood I-Joists, reissued August 1, 2011. 
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Addendum 5/8/12 

Consequent to a recent update in the embedded open-web truss analysis engine also 
used in RedOpenWeb™, the load factors for combinations 3 and 4 under IBC ASD are 
revised as follows: 

Previous: 

Combination 3: 1.0 Dead + 1.0 Snow 
Combination 4: 1.0 Dead + 1.0 Roof 
 

Update: 

Combination 3: 1.0 Dead + 1.0 Floor + 1.0 Snow 
Combination 4: 1.0 Dead + 1.0 Floor + 1.0 Roof 
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Release Notes (Archive) 
RedSpec™ 
 Version: 7.0.12 
 Release Date: May 21, 2011 
 Expiration Date: July 1, 2012 

 

 

Contents 

• Purpose of Release 
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Purpose of Release 

The release of version 7.0.12 is coordinated with an update in the open-web truss 
price analysis. Other revisions are included to improve usability. 
 

 

Description of Changes 

Open-Web Relative Price 

When the user selects multiple truss series, depths, or spacings, RedSpec produces a 
list of candidate trusses ranked by relative price. The component costs in the analysis 
are updated in accordance with current RedBuilt pricing. 

Beam Properties 

• All available widths and depths of RedLam™ LVL are added for Canadian design, 
which previously was limited to 1.75" widths. Density of all RedLam LVL is 
changed from 40 to 42 pcf. (Note: Member weight is added to dead load on 
beam designs.) 

• Allowable shear of glulam beams available for US design is changed from 240 to 
265 psi in accordance with 2005 NDS. 

User Interface 

• Several graphical elements are revised and tooltips are added. 
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• An indication of the direction of positive and negative slope appears on screen 
and printout. 

• The user is advised to exit RedSpec during the update process to prevent two 
instances of RedSpec running simultaneously. 

• VB6 runtime files are no longer distributed with updates and setups. 

Bug Fixes 

1. Graphical displays of simultaneous plf and psf loads do not appear in correct 
proportion for given tributary width.  

2. Graphical displays of point loads sometimes not shown unless design is closed 
and opened.  

3. Graphical displays of negative replacement load appears positive in certain 
conditions. 

4. “Ending location” error message appears after entering a point load in certain 
conditions. Design is allowed to proceed. 

5. “Sort failed” error message appears due to I-joist hole location. 
6. Adding a new folder to the project tree changes application loads to defaults 

on original design. 
7. Vibration and safe load analyses are not executed on alternative designs 

selected in the results grid. 
8. Snow(115%) and Roof(125%) loads are allowed in the same load combination. 
9. Depth-to-width ratio error triggered when switching member from deep I-joist 

or truss to beam. Design is allowed to proceed. 
10. Greatest depths in listbox disappear when width of beam is changed. User must 

reselect beam series to repopulate depth list. 
11. Can’t design 24f-V8 glulam or DF#2 sawn lumber. 24f-V4 and DF#1, 

respectively, are designed in lieu of them. 
12. Dead load reactions of a continuous beam design are overstated when 

concentrated load analysis is included. 
13. “Hole too wide” error message appears, but design is allowed. Design fails due 

to hole position issue, but it should not be allowed. 
14. “Holes too close” error message appears in certain circumstances when holes 

are an acceptable distance apart. 
15. I-joist optimization analysis results in an overstressed Red-I45 design when 

other valid designs are available. 
16. Plies control is disabled when a beam type is active in the project tree, then an 

I-joist type is selected in the tree. User must close and open design to proceed. 
17. Sheathing type is not set to default when switching building code from NBC to 

IBC. Control should remain visible so user can choose sheathing type under IBC. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.11 
 Release Date: March 24, 2011 
 Expiration Date: July 1, 2012 

 

 

Contents 

• Purpose of Release 
• Description of Changes 

 

Purpose of Release 

Version 7.0.11 addresses a critical bug found soon after the release of 7.0.10. The bug 
causes a conservative error, but is deemed critical because it limits the capacity of 
certain open-web truss designs. See below for a more complete description. 
 
In addition this version includes other bug fixes. 
 

 

Description of Changes 

Bug Fixes 

1. RedSpec uses a load duration factor of 100% instead of 115% in these 
conditions: 
 

a. RedSpec version: 7.0.10. 
b. Building code and methodology: IBC ASD. 
c. Member application: Roof. 
d. Member type: Open-web truss. 
e. Application loads: Snow roof (115%). 
f. Files: New and existing (i.e. all versions). 

 
The erroneously low duration factor may prevent the user from identifying the 
least expensive options of series, depth, and spacing. Also, a working design 
from a previous version may fail in 7.0.10. 
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The bug does not affect Canadian designs, floor designs, roof (125%) designs, or 
any I-joist or beam design. 

2. The I-joist bearing control defaults to the lowest value (minimum bearing 
length, no web stiffeners) when the minimum and maximum values with web 
stiffeners are equal. This affects end bearings of the Red-I90HS™ less than 20" 
deep, potentially failing the design erroneously, but only if the design reaction 
is in the range of 100.0% to 100.5% of the correct allowable. 

3. A “subscript out of range” error prevents the design of Canadian I-joists with 
holes. 

4. The selection of blocking rows is ignored in the computation of FloorChoice™ 
rating (version 7.0.10 only). 

5. Load locations very close to the left end of the member are moved when the 
file is re-opened due to a misreading of the scientific notation. For example, a 
point load at 1" from the left end (8.3333E-2 feet) is moved to 8.3333 feet, or 
8'-4". This affects load locations that are greater than zero but less than 1.2". 

6. When switching from IBC ASD to NBC LSD, and vice versa, application loads are 
not reliably translated. Note that the application load magnitudes frequently 
change when switching building code. This bug refers to the internal load ID. 

7. When changing application load type from “Snow roof (115%)” to “Snow roof 
(100%),” the “Save changes?” prompt is not triggered on closing, potentially 
resulting in loss of the change. These loads are only available under IBC ASD. 

8. During uninstallation, a dialog asks if the user wants to remove all files. The 
user’s response is ignored. Files are removed regardless of clicking “Yes” or 
“No.” 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.10 
 Release Date: March 16, 2011 
 Expiration Date: July 1, 2012 

 

 

Contents 

• Purpose of Release 
• Description of Changes 

 

Purpose of Release 

Version 7.0.10 is an unrestricted release of the updates first made available in version 
7.0.9, whose focus was the introduction of the National Building Code of Canada to 
RedSpec™. Please read the archived release notes in the following pages for a full 
description of changes. 
 
In addition this version includes bug fixes and minor interface changes. 
 

 

Description of Changes 

Hanger Database 

The US hanger database has been updated to the latest available from Simpson 
Strong-Tie®, dated 3/1/2011. The changes that affect RedSpec™ are: 

• Previously, the program required web stiffeners on any I-joist 18 inches or 
taller, regardless of other criterion. That requirement has been removed.  

• Load limitations have been added to 3-1/2 inches and wider light-gauge 
hangers carrying an I-joist with no web stiffeners. 

• Loads have been updated per changes in the 2011 catalog. 

• Please note that all of the 2010 version DLLs will stop working on 12/31/2011. 
This will only affect RedSpec™ users who choose not to update prior to the end 
of this year. 
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Printed Warning for Large Point Loads on I-Joist 

RedSpec™ displays an on-screen warning when an unfactored point load exceeding 
1500 lb is applied to an I-joist. The warning advises the user about the need for web 
stiffeners to support large point loads. This warning now appears on the Results tab 
after running the design, and it appears in the bulleted notes on the printout. The 
1500 lb criterion is used for all I-joist members regardless of the number of plies, 
since there is no assurance that a point load is evenly distributed to each ply of a 
built-up member. 

Bug Fixes 

1. In some conditions while switching from one building code to another, the 
depths available on the Design tab show only a single depth where there should 
be two (tapered) or three (pitched). The bug originated in version 7.0.9. 

2. A user reported an instance where a Red-I65™ joist is designed, even though a 
Red-I45™ is selected. 

3. A best-systems analysis of an I-joist design results in “no feasible option,” 
where a Red-I90HS™ solution should be offered. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.9 
 Release Date: February 23, 2011 
 Expiration Date: July 1, 2012 

 

 

Contents 

• Purpose of Release 
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Purpose of Release 

Version 7.0.9 enables design according to the 2005 National Building Code (NBC) of 
Canada. The methodology is Limit States Design (LSD). Wood design is in accordance 
with CAN/CSA-O86-01 (reaffirmed 2006), “Engineered Design in Wood.” Red-I™ joists, 
RedLam™ LVL beams, RedBuilt™ open-web trusses, and two grades of glulam beams 
are available for design under the “NBC LSD” code selection. The audience for this 
release is restricted. 
 
A few maintenance items and bug fixes are also included in this version. 
 

 

Description of Changes 

Canadian Design 

In previous versions the only building code available was the International Building 
Code (IBC), using Allowable Stress Design (ASD). Implementation of NBC LSD entails a 
number of changes: 
 

• RedBuilt™ product properties: Properties such as shear and moment resistance 
and bending stiffness are taken directly from the CCMC Evaluation Reports for 
the respective products1. RedSpec™ operates with imperial units, so the CCMC 

                                                
1 Evaluation Reports CCMC 13487-R, issued 2010-02-23, and CCMC 13485-R, issued 2010-02-16, National 

Research Council Canada. 
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properties are converted from SI to imperial units without rounding. Composite 
stiffness is calculated using sheathing properties tabulated in CAN/CSA-O862, 
thus deflection of composite members (i.e. those with glued and nailed 
sheathing) will vary between the two building codes. 

• Application loads: Application loads may be selected according to the 
terminology provided in the NBC table of uniform live loads3. These are 
provided for convenience; the user may override any load. 

• Load combination factors for joists and beams: RedSpec™ does not 
incorporate the full gamut of load combination factors allowed in the code4. It 
is conservative to use a factor of 1.25 on dead load and a factor of 1.5 on all 
live loads (floor, snow, wind, quake), so these are the factors employed in 
RedSpec™. One exception is the case that includes only dead load. Here the 
factor is 1.4 on dead load. The user is responsible for reducing dead load in 
uplift conditions, as is the case under IBC ASD as well. An importance factor of 
1.0 is assumed for all loads. 

• Load combination factors for trusses: The open-web design engine fully 
implements the combination factors specified in the NBC. An importance factor 
of 1.0 is assumed for all loads. 

• Load duration factors: To facilitate application of load factors, the former 
numerical duration factors have been discarded in favor of text durations, 
affecting both building codes. The dropdown list on additional loads included 
durations of “100” and “115,” for example. These have been changed to 
“Floor,” “Snow,” “Roof,” “Wind,” and “Quake” where appropriate. Another 
change required by the NBC is the “permanent load factor,” which applies 
whenever dead load exceeds standard-term loads5. 

• Canadian Vibration Criteria (CVC) for floor joists and trusses: The criteria for 
evaluating floor vibration characteristics6 have been implemented, with several 
options for floor sheathing, topping, ceiling, and blocking. The RedBuilt™ floor 
performance measure, FloorChoice™, is simultaneously available for joist 
design. 

• Analysis: A second check on compressive resistance perpendicular to grain is 
specified in CAN/CSA-O86 for beams7. This is implemented with an increase of 
4/3 on required bearing length to account for assumed average bearing. The 
Canadian lateral stability factor and volume factor for beam design8 have been 

implemented. The shear load coefficient for large (volume ≥ 2.0 m2) glulam 

                                                
2 CAN/CSA-O86-01 (reaffirmed 2006), Engineering Design in Wood, Canadian Standards Association, pp. 68-69. 
3 National Building Code of Canada 2005, Volume 1, National Research Council Canada, Division B, pp. 4-8, 4-9. 
4 CAN/CSA-O86-01, p. 17. 
5 Ibid, p. 18. 
6 Concluding Report, Development of Design Procedures for Vibration Controlled Spans Using Engineered Wood 

Members, Canadian Wood Council et al, Sept. 4, 1997. 
7 CAN/CSA-O86-01, pp. 59, 170. 
8 Ibid, pp. 49-50. 
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beam factored shear resistance9 has been included in a conservative form that 
assumes maximum shear throughout the length of the member. 

• Hangers: The hanger selection component toggles with the building code. 
Canadian hangers are selected based on factored loads. 

• User interface: The user may select building code on the Project tab. 
Additionally the user may set a default building code via the Options menu. 
This determines the building code of new files, but does not affect the code of 
existing files, so the user will be able to open and work with any file without 
affecting the saved choice of code. Products available on the Design tab are 
selected for the Canadian market. Printed output specifies whether the 
quantities are factored or unfactored, and includes evaluation of the CVC 
vibration check as a PASS/FAIL criterion. 

 

Compatibility 

Version 7.0.9 is backward-compatible. Any existing RedSpec™ file may be opened; it 
will appear with the building code set to “IBC ASD.” However, previous versions of 
RedSpec™ will not be able to open files that are saved in version 7.0.9. 
 

Bug Fixes 

1. Fixed the member copy procedure so that joist hole information is also copied 
to the new member. 

2. When a point load was applied directly over a support on a continuous floor 
joist with concentrated load (aka safe load), the analysis erroneously increased 
the shear and moment in the span to the right of the support, which could fail 
the design. This has been fixed. 

3. Fixed a bug that caused the member icon of beams or trusses to appear as a 
joist in some conditions when opening an existing file. This interface bug 
appeared only in the project tree and did not affect the analysis. 

 

                                                
9 Ibid, p. 55. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.8 
 Release Date: December 9, 2010 
 Expiration Date: July 1, 2011 

 

 

Contents 

• Purpose of Release 
• Description of Changes 

 

Purpose of Release 

Version 7.0.8 addresses bugs that have been reported in the last release version, 
7.0.7, dated August 11, 2010. No new features are included in this release. A number 
of interface methods have been revised. 
 

 

Description of Changes 

First Use 

First-time users would start the software to a blank gray window after installation. 
This forced them to use the “New” command to begin their first design. This has been 
changed so that a Project1.red file appears. There is no “Save As” command for the 
user to change the name of the project, but this alternative may be better for first-
time users. After the first use, the last-used file is always opened (if available), as 
before. 
 

Default Sheathing for Floor Performance 

On new project files, the sheathing default was 20 oc span-rated sheathing (19/32", 
5/8"). This sheathing is thought to be used rarely, so the default was changed to 24 oc 
span-rated sheathing in order to yield a floor performance rating that is applicable in 
more systems. 
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Concentrated Load 

When a design failed in deflection, the analysis did not continue with the 
concentrated load check. This was revised so the concentrated load check is carried 
out regardless of the status of any other control. 
 

Uplift Reaction Warning 

The software previously failed a design when uplift exceeded 500 lb. A message would 
be displayed, but the output would say, “OVERLOADED” with no indication of why. 
This was revised to display a warning about the uplift reaction over 200 lb. The design 
does not fail based on uplift reaction. 
 

Hanger Selection Engine 

The latest hanger selection .dll has been included in the update. The file is dated 
8/16/10. 
 

Bug Fixes 

1. Removed rounding of span lengths that appear on diagram in load screen. Users 
may refer to the diagram as they input loads, so the rounding may lead them to 
input a load location that is slightly off the end of the span. 

2. Fixed saving of beam width input. Beam widths greater than the narrowest 
available width would default to the narrow width when the project file was 
opened. 

3. Fixed saving of hanger slope. If the user chose a slope that did not match the 
joist slope, the hanger slope would default to the joist slope when the project 
file was opened. 

4. Fixed a “division by zero” error due to an allowable of zero when no product is 
found. 

5. Fixed an error on the hanger screen. When a double nailer was chosen as the 
header, the header width was calculated to be twice the width of a single 
nailer when in fact it would be the same as the single nailer, since the nailers 
are stacked, not side by side. Header width affects the compatibility of top-
flange hangers. 

6. Fixed bug related to hole design. If the user designed a joist with a hole, then 
switched the member to a truss, it was possible to get hole design information 
on the truss by cancelling the warning messages. The fix removes holes from 
trusses and beams if the member is switched away from joist. 

7. Slight differences in span input vs. span lengths on the printout were fixed. 
Differences of a few hundredths of an inch were observed. 
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8. Fixed run-time error that occurs when entering or pasting in a long folder name 
to the project tree. Input is now truncated to the string limit. 

9. Joists with two overhangs had a bug in the deflection output. Even if the right 
overhang was critical for deflection, the span ratio on the output was based on 
the length of the left overhang. Pass/fail and actual deflection in inches was 
correct, but the ratio was wrong. 

10. Fixed bug on mixing of roof load types. If the application load and an additional 
uniform load were entered as either snow or roof, but then switched from one 
to the other, an error message would say that mixing of snow and roof loads 
was not allowed. This was fixed so the message appears only if load mixing 
actually occurs. 

11. A run-time error could occur if the last-used drive becomes unavailable, 
making the last-used file unavailable. The error is trapped so a program crash 
is prevented. 

12. A bug on beam depth could not be duplicated, but a safeguard was 
implemented. A user reported that the depth shown on the printout did not 
match the selected beam depth, although the design allowables did. The depth 
is now checked before the printout is displayed. If there is any discrepancy, a 
message asks the user to run the design again. 

13. A loading error could occur if a span was removed or shortened, causing a load 
to fall off the end of the member. Such loads are now removed or shortened as 
well to prevent the error. 

14. Allowable deflection in inches could vary by a couple thousandths of an inch. 
This was corrected. 

15. The member spacing for double or triple joists did not appear in the printout 
banner, as it did for single joists. The printout was revised to emphasize 
spacing. 

16. Joist spans were limited to 70', while truss spans were limited to 60'. This is the 
converse of proper span limits, and could lead to a run-time error if the joist 
design was attempted. This was fixed. 

17. Fixed the bug that caused the results to disappear when the save button was 
clicked. No data was lost, but the bug forced the user to design again. The bug 
only occurred on the first save. 

18. Spans less than two feet are not allowed for joists. The user is informed of span 
errors, but a bug allowed the user to design the joist anyway. This was fixed so 
that the span was set to minimum length automatically. 

19. Fixed a bug that allowed the floor performance rating to appear on roof joist 
designs. 

20. Added user warnings about approaching or exceeded kill date. The software 
does not function once the kill date is reached. Without these warnings, there 
was no indication of why the software would not start. 

21. Deflection controls were aligned with strength controls so that anything less 
than 100.5% passes. Previously deflections had to be less than or equal to 100%. 

22. Fixed a bug that displayed a 4' span as 3'-12.0" on the output. 
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23. Fixed a bug that occurred when the user attempted to add a uniform load with 
negative live load and positive dead load that happened to sum to zero. A 
warning message would appear, but then the load would appear to be tapered. 
The revision resets the load to a uniform value. 

24. Fixed output for hole design. The comment string was overlapping the size and 
location string. 

25. Software was not allowing holes with spacing as allowed by the code report 
(two times the diameter or largest dimension). Spacing allowance was revised 
to match code. 

26. The note about “geometric constraints” has been revised. The wording was 
changed to offer more detailed advice, and it now appears on output only if 
the truss design is otherwise feasible. Before it would appear on a failing 
design, which gave the impression that this was the reason it failed. 

27. Fixed startup issues due to Canadian date format. 
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Release Notes (Archive) 
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Purpose of Release 

This is the first unrestricted release of RedSpec™. 
 

 

Description of Changes 

Save As… Command 

The “Save As…” command has been removed from the File menu. The “Save As…” 
method was not typical: if the user closed the original file without saving changes, 
the changes were not included in the copied file, either. There was the risk that a 
typical user might save to a new file and unexpectedly lose current changes. 

Until the method is revised to behave in a typical way, the RedSpec™ user must use 
Windows® to copy a project file. 
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Bug Fixes 

1. The user entered a decimal number in the member slope. The entry was lost 
when the file was closed and re-opened. 

2. When the user inadvertently entered a large tributary width (e.g. 27'), the 
program encountered a run-time error and quit. 

3. The user entered a 14.5" depth, but RedSpec™ designed a 14" truss. 
4. When the user changed from a tapered open-web to parallel and clicked the 

Design button, the program encountered a run-time error and quit. 
5. The user found no available hangers for the right end of a joist, although the 

left end had several choices in identical conditions. 
6. RedSpec™ returned a failed truss design, but later designed the same truss 

successfully. 
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Release Notes (Archive) 
RedSpec™ 

 Version: 7.0.5 
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Description of Changes 

Concentrated Load 

The magnitude of the concentrated load used in the analysis of I-joists and 
rectangular sections has been revised. Previous versions considered the input value as 
distributed uniformly over a 2.5' square and converted it to a point load based on 
member spacing. For example, a 2000 lb concentrated load is 320 psf over the 2.5' 
square. At 16" o.c., the equivalent point load on the member would be 1067 lb. 

That method is quite conservative in that it ignores the load-sharing effects of 
sheathing. Particularly on closely-spaced joists, the concentrated load will be 
distributed to adjacent joists to some degree. 

The revised method calculates the equivalent point load according to these rules: if 
the spacing is 24" or less, the input value is divided by two; if the spacing is greater 
than 24", the input value is used at full value. In the example above, the equivalent 
point load would be 1000 lb under the new method. 

Design shear at I-joist holes also has been revised according to these new rules. 

The placement of the point load in the analyzed load cases is not affected by this 
revision. The method of analyzing concentrated load in open-web design is also not 
affected. 
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Lateral Support at I-Joist Bottom Flange 

RedSpec™ reduces the allowable moment of an I-joist based on the input lateral 
unbraced length found on the Spans tab. By trial-and-error, the user has been able to 
find the maximum allowable unbraced length on top and bottom flanges. 

The method had drawbacks when considering bottom-flange bracing. The extent of 
the bottom flange under compression is not calculated, so it is not possible to judge 
whether bracing is required, even when the maximum unbraced length is known. For 
joists subject to net wind uplift, RedBuilt™ uses an independent calculation of 
unbraced length that is not incorporated into RedSpec™ at this time. 

Since uplift bracing and bracing of joists with overhangs is calculated independently, 
the lateral support control for the bottom flange of I-joists has been removed from 
the Spans tab. The allowable moment is not reduced by a stability factor when 
considering negative design moment. It is noted in the design results that “Lateral 
support at bottom edge shall be per RedBuilt recommendations.” 

The ability to control bottom lateral support of rectangular sections has not been 
changed. Lateral support for the bottom chord of open-web trusses continues to be 
per RedBuilt™ recommendations. 

 

PDF Save Folder 

RedSpec™ has been revised to default to the last folder used when saving a PDF 
output. 

 

Hanger Database 

The hanger database has been updated to the latest available from Simpson 
Strong-Tie®, dated 6/17/2010. 
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Bug Fixes 

1. Under the following conditions, RedSpec™ did not correctly calculate the 
required bearing length for hanger design on the right end of the member: 
 
- Member type: I-joist 
- Depth: 18" or less 
- No overhang on left end of joist 
- Hanger present on right end of joist 
- Reaction capacity is exceeded on the left end of the joist 
 
Hangers on the left end were not affected by this bug. 

2. When the user tried to optimize by I-joist series by clicking “(Select All),” 
RedSpec™ would try only the first series in the list, the Red-I45™. Users should 
now obtain results for other series of joists in cases where a heavier series is 
required. 

3. Users were only allowed to choose member slope from the dropdown list on the 
Spans tab. RedSpec™ has been revised to permit the user to key in any slope 
within the imposed limits. 


